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It doesn’t get much better than laying out the monthly magazine while watching the many events of
the 30th Summer Olympiad of the modern era from London. While the time zone differences may
force many to watch events on a tape delay
(many events here in the U.S. are televised this
way), there’s little else that equals or approaches
the splendor and the spirit of peaceful, albeit
intense, competition of the quadrennial Summer
Olympics.
Maybe that’s what ms_meme is doing this month
– enjoying the Olympics – as she takes a month
off to regroup and recoup. Ms_meme hasn’t
missed a single month of regaling us with her
musings and songs since the magazine’s “reboot”
in July 2009. But you won’t have to go cold turkey
from getting your “fix” of ms_meme’s musings.
We’re going to run a couple of ms_meme’s
“classic” columns. She has informed us that she
plans to return with the September issue.
Meanwhile the dog days of summer are definitely
upon us. Much of the middle U.S. is embroiled –
and boiled – in a drought and is enduring an
oppressive heat wave. My wife and I have
adapted to the harsh weather by transferring
most of our daytime outdoor activities to night
hours after the sun sets, or very early in the
morning, before the sun rises high in sky. During
the day (when we aren’t working at the hospital),
we are spending much of our time indoors,
seeking relief from the heat by spending the
hottest part of the day in the air conditioning. Ugh.
So, until next month, I wish each of you
prosperity, happiness, serenity and peace. Stay
cool – if you can.

1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer
Welcome From The Chief Editor
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by Meemaw

KMyMoney is our next program. The website is
http://kmymoney2.sourceforge.net/index­home.html
and it is available for Linux, Mac and Windows. The
User Guide is at
http://kmymoney2.sourceforge.net/online­
manual/index.html. This program is also in the
PCLinuxOS Repository.
Opening it for the first time, we see this window:

You can see, at the left side of the smaller window,
the steps the program will take and what information
you will need to set it up the first time. Notice that
the setup program also takes you to your
Preferences window, so you can set preferences at
the beginning. As with previous programs, you can
always change your preferences and add accounts,
payees and categories later.
We will assume you have set up and named your
working file. You will now see the KMyMoney

window as shown below:

Double­clicking on the account name, you will be
taken to the ledger where you can now add
transactions. At the beginning, you will be asked if
you want to save every payee. If it is one you use
frequently, you should save it. After you have
entered many of your transactions, the window will
look similar to the one below:

The ledger is at the top, showing your transactions,
and the transaction editor is at the bottom. This is an
easy form to use to enter each transaction. Make
sure you choose the correct tab (Deposit, Transfer or
Withdrawal). I wish I had more deposits and less
withdrawals!

In the left­side panel are many of the tools that you
can use to maintain your account correctly.

Home ­ You can configure KMyMoney to open a
Home page when it first starts. This page can have
as few or as many items as you wish. You can view
the following items: Assets & Liabilities, Payments,
Preferred Accounts, Payment Accounts, Favorite
Reports, three different Forecasts (including Net
Worth), Budget and Cash Flow.

Institutions ­ In this window you can see the
institutions you have added (banks, credit unions,
stockbrokers and so on) and can edit any one of
them here.

Accounts ­ All the accounts you have listed
(checking, savings, investment) are listed here and
can be edited.

Categories ­ You have your whole list of categories
here and can add, delete or edit them. You will start
out with a basic list of categories, but I’ve never
used any of these programs where I didn’t have to
add a few of my own. For example, KMyMoney has
a category named Transportation which has as sub­
categories Car/Auto and Public Transportation. I
would change that category so it was called Vehicle,

Linux Financial Apps: KMyMoney

http://kmymoney2.sourceforge.net/index-home.html
http://kmymoney2.sourceforge.net/online-manual/index.html
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remove Public Transportation (because my town is
too small to have taxis or buses), and change
Car/Auto to the type of car I drive (could be
Chevrolet Impala) and then add another sub­
category called GMC Pickup for the truck we own.
All the entries in those categories would be the
same (Fuel, Repair, Insurance, Payments,
Registration/Tags and Taxes). That way we have a
separate record of expenses for each vehicle. You
can also delete any categories that don’t apply to
you.

Payees ­ Every time you enter a check to a new
payee, KMYMoney will ask you if you want to add
the payee to your Payee list. You can click Yes
during every transaction if you want. However, you
can also go to this section and add them from here.
If you have a dozen or so you pay on a regular basis
(rent, groceries, fuel, insurance, utilities, internet),
you can always just enter them all from here and
when you enter your transactions, the process will
go more quickly. When you start typing in a payee,
the program will find the one that matches most
closely, and if it is correct, you can simply tab over to
the next field. If you decide to delete a payee, you
have to re­assign each transaction using that payee
to a new payee.

Ledgers ­ The is the window which shows the
register for each of your accounts. You can continue
to add transactions here. Make sure the appropriate
account shows in the drop­down.

Investments ­ This section is where you see your
investments. You can enter the investments from the
ledger screen, bringing up your Investment account
and adding transactions. If you bought stock for a
certain price and the price has changed, you can
see the present value in the Investments section.
You first have to go to Tools and update the stock
prices from your chosen source. As shown below, I
had entered a stock purchase for $185 per share a

couple of weeks ago, but when I updated prices
today, the price per share has changed.

Reports ­ KMyMoney has many reports in this
section. You can choose a pre­designed report and
edit it to your liking, then save it in Favorite Reports.

Budgets ­ Budgets are useful as a financial
roadmap. Here you can enter your income and
expenses. Keeping an eye on it, and the report
“Budget vs. Actual”, will help you know if you have
any potential problems. Create a new budget, then
for each income and expense category, enter the
amount you pay or an estimate of it for every month.
For periodic payments, like my auto insurance which

I pay every six months, click Individual in the Period
section and enter the amount in the appropriate
months. Make sure you enter your income too.

Forecast ­ A Forecast is a prediction of the balances
of Accounts during a specified future period of time.
You can predict balances using one of two methods,
Scheduled and Future Transactions or History­
based. For Scheduled and Future, KMyMoney uses
a combination of future transactions already entered
into the ledgers and the entries in the Schedule. For
History­based, KMyMoney uses values from past
transactions in the ledgers to predict future
transactions. You have to set up the period you want
to see.

Outbox ­ The User Guide says this is an add­on for
online banking. Since I don’t use KMyMoney, I didn’t
try to set it up.

Summary
KMyMoney is a good program, which is well
organized. If you are a KDE user, or don’t mind all
the KDE packages that install with it, you will like
KMyMoney. Next time, we will finish our series with
Skrooge.

Linux Financial Apps: KMyMoney
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Posted by MGBguy, July 23, 2012, running KDE 4.
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by Paul Arnote (parnote)

Last month, we took a “get acquainted” look at
KompoZer. Now that we have the “tool,” it’s time to
set up some kind of blueprint for our web site. In the
same manner that you wouldn’t expect a builder to
build you a house without a set of blueprints, you
also shouldn’t expect to build your home on the web
without a blueprint. Planning is key to a functional
and well organized web site.
Before you start gathering your text and graphics,
you need to have an idea of how you want to
present your home on the web. Nothing has to be
“set in stone,” but you should at least have a vision
of what you want things to look like when you’re
through. Often, your “plans” will have to be flexible
and you may find yourself changing some details of
your plan as you progress through the site planning
and site preparation stages. Sometimes, you may
find yourself scrapping your initial plan and replacing
it with a different one.
I know I said in the first KompoZer article (June 2012
issue) that we’d start learning to create our first web
page—and we will, later on in this article. However,
there’s a lot more to creating a website than just
throwing a bunch of text and graphics together. If
you just throw some text and graphics together, you
will likely cause yourself more work in the long run.
You will find yourself having to redo things you’ve
already done if you proceed without some
semblance of a plan. Plus, your website will likely
look as if you just threw some text and graphics
together. The planning stage is much too important
to skip over.
One good way to plan out your website is to make a
representation of the site structure (site map) with a

diagram or flowchart. Similarly, you could use Post­It
Notes plastered on a wall, with each Post­It Note
representing one link. You could get fancy and
represent links to external sites with one color of
Post­It Notes and represent internal links to pages
on your site with a different color of Post­It Note.
Below is one example of a possible web site.

Here’s another example (top of next column), using
the website for The PCLinuxOS Magazine as an
example (a couple of pages/links were omitted to
help improve clarity).
As you can see, things can get fairly complex very
quickly. You have to think out and plan the
navigation for your site. It’s best to do this from the
perspective of a typical user. Try to anticipate how a
user might want to navigate your website.

With the magazine website, I’ve made every attempt
to prevent a visitor to the site from heading down a
“dead end” link. That is, they can access every other
part of the site from wherever they may happen to
be, at least in regards to the local pages. Whenever
I link to an off­site web page, I create the link to the
off­site web page to open in a new window or tab.
This allows my users to remain on my site, and to
return to where they jumped off when they are
finished with the off­site content.
You will notice that in the first example diagram,
things link to the “Home Page” at the top. In the
abbreviated site map for the magazine website, you
notice that everything revolves around the
“index.html” page. There is no one “right way” to
organize your website.
Standard use of HTML has always dictated that your
“Home Page” is named “index.html.” This is so that if
a user simply enters your web address into their

KompoZer, Part 2: Let's Get Started
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browser’s address bar without a specific page, their
browser will automatically look for and load the file
named “index.html.” As such, “index.html” should be
the filename for the “Home Page” of your website.
Once you have your website structure planned, it’s
time to gather and organize the elements that will
make up your website content, and make some
decisions about its appearance. These include, but
are not limited to:
1. the text for your site
2. images for your site
3. background for your site pages

(solid color vs. background image)
4. the font for your page
5. the width of your pages
6. whether there will be files offered for download
As you can see, creating an organizational plan is
very important for your website. It’s certainly worth
the effort, since having a decent organizational plan
can actually make it much easier to create your
website.

Once you have your website structure set up, you
will also need to set up the directory structure for
storage of the files that make up your website.
Above is a snippet from Thunar of our sample
website. The “files” directory is where any files you
might offer the user an opportunity to download are
stored. The “images” directory is where the images
that are displayed on the website are stored. I
strongly suggest mirroring the directory structure of
your website in a folder on your computer.

Creating Our First Page
Let’s start off by first setting the background color for
our web page. Select “Format > Page Colors And
Background” from the KompoZer menu. You will see
the window below.

Select the “Use custom colors” option, then select
the color swatch after “Background.” You will be
presented with the typical color selection dialog box
(top of next column).
You can now select the color you want to use from
the color swatches at the upper right corner of the
dialog box. For my demonstration, I chose the blue
color in the third column from the right, third down
from the top. If the color you want to use isn’t
displayed in one of the default color swatches, you
can specify the specific color.
The easiest way is to pick a “close” color, then adjust
the Hex or Red, Green and Blue values until you get

the precise color you want. The selected color is
displayed in the color swatch (white in the image)
that appears between the RGB settings and the Hex
value for the color. Another easy way to fine tune
your color selection is to adjust the black slider in the
color bar just above the Hue, Saturation and
Brightness values.
If you’d rather use a background image, you can
specify the image location in the text entry box at the
bottom of the first dialog box. So that the image can
be found when needed, place the image in the
location it will be in on the server – on the mirrored
copy on your hard drive. Check the “Url is relative to
page location” checkbox. Be careful using
background images, as many images will render
your web page difficult to read (like when you’re
attempting to display black text over the top of a
dark area of the image) and may be a distraction.
Below (top of next page) is what my KompoZer
window looks like after selecting the background
color:

KompoZer, Part 2: Let's Get Started



PCLinuxOS Magazine Page 9

Next, select “Format > Page Title and Properties”
from the KompoZer menu.

Enter the title for your new web page, and set the
language and text direction. I’ve entered the page
title as “My Home Page,” but you should call it
whatever you think is most appropriate.

Next, set the font information for your web page. The
default value is “Variable,” but I prefer to set a
particular font. My personal preference is for
“Helvetica, Arial.” It’s the font that has been rated as
the easiest to read by various independent surveys.

Select “Format > Font” from the KompoZer menu,
then select the font you want to use. Although listed,
it’s probably best to not select the listed fonts that
are installed on your computer. You cannot be sure
that your website visitors will have that particular font
installed on their system. As a result, your website
may not appear as you intend it to. It’s best to
restrict your choices to only the first eight choices,
since those will display as intended on most any
web browser and platform.
Next, select the text formatting dropdown list that
says “Body Text,” and change it to “Heading 1.” Now,
place your cursor in the text editing portion of the
KompoZer window, and type “Welcome To My Web
Page” (without the quotes). Press <Enter> at the
end of the line. Notice how the text formatting
dropdown changes back to “Body Text.” Also, if you
notice that your text isn’t formatted to use the font
you previously selected, don’t fret. Just select that
text and reformat your text to use your preferred
font.
Now enter some text into your web page. Just type
in some brief, introductory text. Your KompoZer
window should look something like the following (top
of next column):
Now, type in the names of a few of your favorite web
sites, one per line. Then, let’s highlight each one of
them, one at a time, then click on the “Link” icon on
the KompoZer toolbar. This brings up the “Link Properties” dialog box, as

shown above. Since we’re linking to external sites,
enter the full URL of the website in the top text entry

KompoZer, Part 2: Let's Get Started
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box. If we were linking to another page on our own
site, we would enter only the filename of the page
we’re linking to (e.g., links.html).
In the “Target” section of the Link Properties dialog
box, place a checkmark in the “Link is to be opened”
check box, and make sure “in a new window” is
selected. This will cause the external website to
open in a new browser window, keeping your
website visitor connected to your website.
Repeat these tasks for each of the links you have
inserted into your web page. Your window should
look something like that shown below.

Let’s Insert A Picture
Now, hit the <Enter> key twice. Hold down the Ctrl +
B key to start boldface text, and type “About Me”
(without the quotes). Depress the Ctrl + B key
combination again to signify an end to the boldface
text, then hit the <Enter> key.
I have already placed an image in the “images”
folder, within my HTML directory structure. Select
the “Image” icon on the KompoZer toolbar, and
select an image in your “images” folder in your
HTML directory structure. You’ll notice after you add
it that the “URL is relative to page location”

checkmark is activated, to indicate that the image is
in the directory path where your HTML file is (will
be?) stored. Enter the tooltip text you want to appear
whenever a visitor hovers their mouse cursor over
the image. Then, enter the alternate text to display
while the visitor is waiting for your image(s) to load.

Next, under the “Appearance” tab of the Image
Properties dialog box, select for your text to “Wrap to
the right” from the dropdown list under “Align Text to
Image.” You might also want to insert the number of

pixels to pad the image edges, so that the text
doesn’t butt right up against the image. I usually use
a five (5) pixel padding. It’s not too much and not too
little, for my tastes. You can also place a solid pixel
border around your image. I like to use a one (1)
pixel border around my images. It helps to prevent
the image from bleeding off into the background.
My image was already pre­sized to the size that I
wanted, and I usually prefer to pre­size my images
to the size I need. It helps prevent unnecessarily
large downloads for my site visitors. However,
another way to get smaller images is to use a larger
image, and under the “Dimensions” tab of the Image
Properties dialog box, enter the dimensions you
want to display the image at. Keep the “Constrained”
checkbox marked if you want the image to be
resized proportionally (height and width are kept
proportional to keep the image from appearing
skewed).
Now, click your mouse cursor to the right of the
image, and start typing a brief introduction to
yourself. The text you type will now “wrap” around
the right edge of the image you inserted. You should
have something that looks somewhat like that below.

KompoZer, Part 2: Let's Get Started
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Save your file in your HTML directory as
“index.html.”

Summary
So far, we’ve learned about the features of
KompoZer (in the first article in the July 2012 issue
of The PCLinuxOS Magazine), and in this article,
how to create a rudimentary web page. As you can
see, KompoZer is a quite capable HTML editor. Next
time, we’ll learn a bit more about KompoZer’s
capabilities. Screenshot ShowcaseScreenshot Showcase

The place where breaking news,
BitTorrent and copyright collide

It's easier than E=mc2
It's elemental

It's light years ahead
It's a wise choice

It's Radically Simple
It's ...

Posted by smudger, July 8, 2012, running KDE 4.

KompoZer, Part 2: Let's Get Started

http://torrentfreak.com/
http://www.pclinuxos.com
http://www.pclinuxos.com
http://www.linfx.com
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MP3 OGG

Reprinted from November, 2011

ms_meme's Nook Reprise:Over The Net & Through The Sandbox

Over the Net and through the Sandbox
In the Neighborhood we'll meet
At ms_meme's Inn where with a grin
She's made lots of grub to eat

Over the Net and through the Sandbox
Now step up to the bar
Have a drink with all your friends
They come from near and far

Over the Net and through the Sandbox
At the table find your place
Have a chat with this and that
Get away from life's rat race

Over the Net and through the Sandbox
Enjoy the chips and dip
Then use Pay Pal to lift his morale
Give Texstar a great big tip

http://pclosmag.com/html/Issues/201111/files/overthenet.mp3
http://pclosmag.com/html/Issues/201111/files/overthenet.ogg
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function. Using this tool, it can
knock out excess white space
around an image/photo,
especially after it's been
scanned in. Autocrop finds the
borders of the image and
crops as closely and cleanly
as possible. Simply select

Image>Autocrop
Image and Gimp will
automatically remove
white space/empty
borders from around
the image. It's helpful
when I need a tight
crop around any of
my comic strips and
game panels.
Autocrop can help
you do the same with
your own photos and
other images.

Mark's Quick Gimp Tip

­Mark Szorady is a
nationally syndicated
cartoonist with
georgetoon.com. He
blogs at
georgetoon.com/blog.
Email Mark at
georgetoon@gmail.com.

In the past, I've shown some
of Gimp's automatic filters and
other tools that work with just
a couple of clicks. One other
such automatic tool that I've
found to be helpful at times is the autocrop

Answers on Page 27

Mark's Quick Gimp Tip & Double Take

www.gimp.org
www.gimp.org
www.georgetoon.com
www.georgetoon.com/blog
mailto:georgetoon@gmail.com
http://www.osu.edu/download/images.php
www.gimp.org
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by AndrzejL
Even though Twitter no longer provides RSS as an
alternative way of following someone’s account if
you are not registered with Twitter, (which is a
shame, because I have just removed my Twitter
account for a multitude of reasons), it’s still possible
to do so by crafting a proper URL:
http://api.twitter.com/1/statuses/user_timeline.rs
s?screen_name=username
So if you want to follow Texstar’s posts, add this to
your RSS Feed reader:
http://api.twitter.com/1/statuses/user_timeline.rs
s?screen_name=iluvpclinuxos
and enjoy the latest news from the world of
PCLinuxOS.

If you are planning on following other PCLinuxOS
developers, here are some addresses you may want
to add to your rss reader:

http://api.twitter.com/1/statuses/user_timeline.rs
s?screen_name=nealbrks
http://api.twitter.com/1/statuses/user_timeline.rs
s?screen_name=pcarchieos
http://api.twitter.com/1/statuses/user_timeline.rs
s?screen_name=hootiegibbon
http://api.twitter.com/1/statuses/user_timeline.rs
s?screen_name=iluvpclinuxos
The list of the links will be updated every now and
then to make sure that I haven’t skipped anyone.

View Twitter Posts As Rss Feeds

Support PCLinuxOS! Get Your OfficialPCLinuxOS
Merchandise Today!

http://www.cafepress.com/pclinuxos


PCLinuxOS Magazine Page 15

by longtomjr

''Rhythmbox is an integrated music management
application, originally inspired by Apple's iTunes. It is
free software, designed to work well under the GNOME
Desktop, and based on the powerful GStreamer media
framework.'' ­ Rhythmbox Site
First let’s get our music library up­to­date. Go to Edit
> Preferences in the “Music” tab. Then, you select
the folder where your music files are stored. Then
tick “Watch My Library for new files.”

Now you can close that window, and under music
you will see all your Music.
Say you want to add a folder that is not in your
“Music” folder. Go to Music > Import Folder and
select the folder. Great, now our music library is up
to date.
Create your own playlist of all your blues songs
First, you right click under the playlists and type in
Blues. Now you just drag and drop all your Blues
songs into your playlist you created.

Enable Live streaming
First, go to www.shoutcast.com. Type your genre in
the search bar and choose one result. Right click on
the radio station you want, and open it in a new tab.
It is now going to ask for a download.
Save that *.pls file just where you want. Now in
Rythmbox, you go to “Music > Import File” and
choose the *.pls file you just downloaded. You will
now see your station under Radio. Double click on
the station and enjoy.
You can add links and *.pls files from other sites. I
just used Shoutcast as an example.

Rhythmbox: A Short Review

http://www.shoutcast.com
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Additional Information
Under “Edit > Preferences > General” you can
choose your browser view. If you have a wide
screen, I would recommend “Genres, Artists and
Albums”. If you have a last.fm account, you can use
Rhythmbox to listen to your music on last.fm. You
can add Podcast feeds by just adding the link to
your podcast. Screenshot ShowcaseScreenshot Showcase

Are viruses,
adware, malware &
spyware slowing
you down?
Get your PC back
to good health
TODAY!
Get

Does your computer run slow?
Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE! Posted by cstrike77, July 1, 2012, running KDE 4.

Rhythmbox: A Short Review

http://www.pclinuxos.com/?page_id=10
http://www.linuxquestions.org
http://www.enkiconsulting.net/
http://pclinuxos.com/?page_id=7
http://ge.tt/93lE3L8?c
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by Darrel Johnston (djohnston)

PCLinuxOS is primarily an English language
distribution. There are French, Polish and Brazilian
forums that I know of. But, PCLinuxOS users come
from all over the world. Many prefer to use the
system in their native language. And, some want to
be able to switch between their native language and
English or some other language. Occasionally, a
new user posts on the main forum, wanting to know
how to switch keyboard languages without logging
out or reconfiguring the preferred language and
keyboard. The answer is the subject of this article.
Although many Linux distributions offer this feature
“out of the box”, PCLinuxOS does not. It is, however,
a relatively easy task to add this capability. First, one
must set up the keyboard for their native language.
In this example, I am using US English as the main
language. Your choice may be different. Open the
PCLinuxOS Control Center and click System in the
left pane and Localization in the right pane. I chose
American English as my language.

And I chose United States as my country.

After saving your settings, click Hardware in the left
pane of PCLinuxOS Control Center and Setup the
keyboard layout in the right pane. I chose US
International keyboard for the keyboard layout and
and 105­key (Intl) PC for the keyboard type.
Close the PCLinuxOS Control Center and open
Synaptic. As a rule of thumb, always completely
update your system before adding any new
packages. Do a search in Synaptic for “locales”
(without the quotation marks). There will be a main
locales package already installed. There are many
language localization packages listed. Choose the
languages you wish to use and install the

corresponding locales packages. I chose Arabic and
Russian. After the locales packages are installed,
close Synaptic.
For the last step, open the text editor of your choice.
Paste the following text into the editor’s window.
[Desktop Entry]Name=Keyboard­toggleComment=Toggle between keyboard layoutswith Alt­ShiftEncoding=UTF­8Exec=setxkbmap ­optiongrp:switch,grp:alt_shift_toggle,grp_led:scroll us,ar,ru

Toggle Your Keyboard Between Languages
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Icon=/usr/share/icons/gnome/48x48/devices/keyboard.pngTerminal=falseType=ApplicationCategories=GTK;System;Monitor;X­MandrivaLinux­System­MonitoringStartupNotify=false
Save the file as ~/.local/share/applications/
Keyboard­toggle.desktop. (The ~ symbol represents
your home directory, and the system will treat it as
such.) Notice the “us,ar,ru” portion at the end of the
“Exec=” line. Change those entries to whatever
languages you are using. You can use more than
two languages. Saving the file in your home
directory will ensure that no system updates will
overwrite the desktop file. Once it is saved, you will
have a new entry in the More Applications >
Monitoring section of the main menu, named
Keyboard­toggle. To enable the keyboard switcher,
run Keyboard­toggle from the menu. The Alt­Shift
key combination will switch between your choice of
languages. Shown below are US English, Russian
and Arabic entered in a text editor. The Arabic
portion is on the right side of the window because
Arabic is one of the languages that is written from
right to left.
To automatically start the keyboard switcher every
time you log in, add it to your desktop as a startup
program.

Screenshot ShowcaseScreenshot Showcase

Want to keep up on the latest that's
going on with PCLinuxOS?

Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos Posted by raed, July 6, 2012, running KDE 4.

Toggle Your Keyboard Between Languages

http://twitter.com/iluvpclinuxos
http://www.distrowatch.com
http://www.tuxmachines.org
http://www.linuxforum.com
http://www.fsf.org


PCLinuxOS Magazine Page 19

by glamdring

About the game
“THE NEXT INSTALLMENT OF THE WORLD'S # 1
ONLINE ACTION GAME! Counter­Strike: Source
blends Counter­Strike's award­winning teamplay
action with the advanced technology of Source™
technology. Featuring state of the art graphics, all
new sounds, and introducing physics, Counter­
Strike: Source is a must­have for every action
gamer.” ~steampowered.com

According to Valve, the games user base just keeps
growing.
“Right now, there are people all over the world
playing Counter­Strike: Source. Odds are, there are
more people playing today than there were playing
yesterday. It, like its predecessor, is quite simply a
global phenomenon, originally created by and now
sustained by the gaming community.

Counter­Strike: Source is a remake of Counter­
Strike, and consequently retains all of its team­
based objective­oriented first­person­shooter style
gameplay. CS:S is a must­have for every action
gamer.” ~valvesoftware.com

Installation
For setting up the game, I use PlayOnLinux.
PCLinuxOS users can find this in Synaptic. Launch
Play On Linux, click “Install” and search for
“Counter­Strike: Source.” When it is done installing
Steam, it should automatically prompt you to install
CS:S. If you already have Steam installed, you
should be able to simply install CS:S. If you are
missing some files, PlayOnLinux will allow you to
install the CS:S packages inside the same bottle as
your current Steam. If you do not own the game, you
can buy it digitally in the Steam store.

Game Information

Release Date: Nov 1, 2004
Minimum Requirements Windows®: 1.7 GHz
Processor, 512MB RAM, DirectX® 8.1 level
Graphics Card (Requires support for SSE)
Recommended Requirements Windows®:
Pentium 4 processor (3.0GHz, or better), 1GB RAM,
DirectX®9levelGraphicsCard
Minimum Requirements Mac: 1GB RAM, NVIDIA
GeForce 8 or higher, ATI X1600 or higher, or Intel
HD 3000 or higher
Price: $19.99 (Often on sale for $5­$10)

Screen Shots
Provided by steampowered.com

Game Zone: Counter-Strike: Source (CS:S)
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Troubleshooting
Some users, especially those with modern graphics
cards, experience issues running CS:S, so I have
included some of the popular fixes.

Disable/suspend your desktop effects, if you have
them enabled (bottom, left). I would suggest doing
this while playing any games in Wine.
Make sure you have the Steam In­Game Community
disabled. You can get to this in the settings menu of
Steam.

Add “hl.exe” to your applications list in Wine
configuration and set it to run as Windows 98. You
can get to this menu by starting configuration in
Wine, or if you used PlayOnLinux, you can simply
select on the bottle/menu entry, click configure, and
under Wine click Configure.

You can also add “GameOverlayRenderer.dll” to
your Libraries, and disable it to ensure it does not
run.

Gameplay
When you first launch the game, you will be given a
list of options. I recommend you first go to your
controls and make sure you are comfortable with the
settings. I suggest you then go to the customize
section and change your name from player to what
ever you want. Most games use this to allow a user
to enter their screen name and gamer tags. You
should also spend some time exploring the options.
You will find some useful things like mouse
sensitivity, volume, and mic controls in the options.
When searching for a server, you can either use the
simple search or the advanced version. I suggest
you get used to the advanced version, because it
allows you to see more servers and the ability to sort
them easily. Some important things to look for in a
server are the ping, VAC, and number of players.
The ping measures the amount of time it takes for a
packet to go from your computer to the host and
back. The lower the value, the better. VAC stands for
Valve Anti­Cheat, which attempts to detect
modifications made to a game to help someone play
a game better. VAC bans will completely remove
your ability to play on VAC secure servers, rendering

Game Zone: Counter­Strike: Source (CS:S)
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the game almost useless. One thing to keep in mind
when looking at servers is not only how many
players are playing, but also the maximum number
of players. If you have a bad Internet connection,
playing on a server with fewer players can help.
After connecting to a server, you will be prompted
with a choice between two teams, Terrorist and
Counter­Terrorist. Most of the time, it is best to hit
auto team select. This will automatically put you on
the team with fewer players or currently losing.
When you select a team you will get the option to
choose your skin, which simply changes the model
of you that other players see. Depending on which
team you are on, you will get a few team­exclusive
guns, and also your skins will be team specific. All
skins and models can be modded to look like
anything you want. However, some servers force
you to use the original ones.
Counter­Strike series is highly customized, so your
starting money, guns, or custom changes may be
different from server to server. Most servers will use
the standard purchasing system to get guns,
meaning you use your money earned in game to buy
weapons at the beginning of each round. The
amount of money awarded is affected by many
factors. Some of the most notable ones are kills,
objectives (bomb/hostage), team win/loss, and
server configuration.

Tips & Tricks
Counter­Strike relies on you purchasing your guns,
other than a default pistol, at the beginning of each
round. The guns are broken down into simple
categories, the most used guns are AK47 and M4 for
Terrorists and Counter­Terrorists, aka T and CT,
respectively. They also have a more powerful rifle ,
SG552 and AUG, which have scopes. Other than
these rifles and the 3 snipers, no guns have scopes
without a special mod. It is important to note there
are no iron sites. You must rely on either the built in
aiming system and or the scope. Snipers don’t have

regular aimers. With this in mind, you will want to
buy the correct weapons for the map, if you have
sufficient funds. I would suggest starting out with the
AK, M4, SG552, and AUG to get familiar with the
game. (Some guns that don’t have scopes can still
do a special function, like burst fire or use a
silencer.)

Equipment
The equipment section will become very important,
especially as you learn how to use some things like
grenades efficiently. The first item you should buy
here is kevlar. If you don’t have the money, you can
skip on the helmet. However, you will run high risk of
being “dinked” in the head by a bullet. If you are a
Counter­Terrorist and it is a bomb map, aka de, you
will have the option to buy a defusal kit. This lets you
diffuse the bomb considerably faster.

Grenades
Grenades are very useful, but can be a bit tricky to
learn to use efficiently. The most important thing to
be aware of is if friendly fire is on or off, aka FF. If
you are unsure, you can type FF into chat to check.
If friendly fire is on, you have to be careful not to get
a grenade too close to a teammate, or you might not
have a happy teammate. Even worse, you could kill
him, and many servers have team kill, aka TK,
punishment systems. Even if friendly fire is on, be
sure not to flash teammates or put smoke grenades
in bad positions. Remember that this is a team
game. Also, you can always hurt yourself, so be
careful not to make that embarrassing accident.

Flash
The most useful and cheap grenades are the
flashbang, which temporarily blinds/blurs the
enemies screen and sound. Even if the enemy isn’t
affected, they most likely had to try and take cover.

This gives you the upper hand in attacking and
retreating. One of the most popular tactics is to to
stop before a corner or door and throw a flash
grenade. This will catch the enemy by surprise and
give you the best possible chance of winning any
firefights.

Smoke
Many servers block smoke grenades, because it can
cause servers and clients to lag so I won’t spend too
much time on them. The smoke grenade produces
smoke in a small area, which can be useful to cover
retreats or blind snipers. Smokes are very useful for
blocking the vision of snipers through doors and
windows. However, it only last a short period, so
make sure you cross while you can. Smoke
grenades have some very useful areas/maps, but in
most cases, you are best off not buying one.

High­explosive
High­explosive grenades, aka HE and frag, explode
a few seconds after being thrown. The damage dealt
is dependent on radius to grenade, renowned for not
doing much damage unless the grenade is very
close to the enemy. However, the grenade has a
relatively high low damage area, so you can easily
inflict 10­20 damage on someone or an entire
group/team with one HE. The most popular tactics
are long range archs and bouncing off walls. This is
one of those things you just get in game to get
familiar with. Many people pick this up rather quickly,
and it’s pretty fun to practice throwing HE grenades
if I do say so myself!

Stance
Your players stance has a lot to do with accuracy
and speed movement. It’s very easy to find yourself
running around and spraying bullets rather than
shooting with accuracy.

Game Zone: Counter­Strike: Source (CS:S)
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Standing
Standing is the default position. It allows for a quick
movement and clear line of sight. Its greatest
downfall is low accuracy. While standing, you have
the option to either walk or run. In order to force
walk, you will have to know the key binding to that
command. Personally, I bind this to one of my side
mouse buttons. That way, I don’t have to be
clicking/holding any other buttons on my keyboard.
While running, you will have the worst accuracy,
other than climbing/falling, which means you will
only get your first few shots off on target. Walking
gives you nearly the same accuracy as standing still.
It also allows you to move without making any noise.
Walking is great for sneaking around, or when you
know someone is in the area. However, when
rushing and using things like flashbang grenades,
you can try rushing in close quarters, so accuracy
doesn't matter as much.

Crouching
Crouching gives you the highest accuracy. However,
you will have to sacrifice movement, speed and line
of sight. Crouching is great for long range shots,
strategic waiting, providing better cover and making
you harder to see/notice. Crouching gives up the
upper line of sight, but grants more lower line of
sight, which allows you to see down through cracks
or feet easier. This can sometimes be useful to get
foot/knee shots, although some servers have rules
against this.

Camping
The term camping refers to waiting/sitting still in one
place waiting for the enemy, typically in a key area
they must come through. This is an action of
refusing to engage/fight, instead waiting at one
point, like a bomb site, for the enemy to come.
Typically, camping is frowned upon in some cases,
like being strongly down/outgunned it is more

acceptable, but not all servers have direct rules
against it. Some servers may have rules saying
“heavy camp.” This usually means it’s okay to do
short term or strategic waiting, but waiting long term
is an offense. A good rule of thumb is to just play as
fairly as you can, and how you would want them to
play if the teams were switched.

Identifying Teams
There are two popular tricks to this. The easiest is
recognizing what Counter­Terrorist and Terrorist
skins/models look like. If you did not alter them by
default, Counter­Terrorists will have helmets and
more tactical looks uniforms, while terrorists don’t
have helmets and have unprofessional/terrorist
looking uniforms. The second method is putting your
aimer on them. A CT will have a blue name and a T
will have a red name. You may notice throughout the
game that this is the way the two teams are
represented. Lastly, keeping track of where your
team is and what they are doing helps a lot. This can
sometimes be hard if you don’t have team players or
lack of voice communication. In some cases, a
server has a public Ventrilo or TeamSpeak server
listed, aka vent and TS. You can also use radar, as
long as it’s enabled, to track your team and enemies
that are making noise/engaged.

Shooting
I covered some of the basic shooting
styles/functions. However, there are many things
you can do to improve your accuracy. You will need
to learn what works best for you, but some of these
basic tactics are great to know. Don’t hold the fire
button on automatic weapons. This is one of the
natural responses to do, but will result in terrible
accuracy. Rapid fire can give good results in close
quarters, but if you want to shoot anyone who isn’t a
few feet away, you need to be aware of the gun
kick/accuracy. You can easily gauge this by how
much the aimer separates/moves and where your

bullets are hitting. To make quick adjustments, you
can lower your aim. The down side to this tactic is
that you will still have poor accuracy and are doing
guesswork. Learning to control your gun can be
difficult and annoying. I found the best tactic is to
use bots on long range maps, or even just choose
things to shoot at on long range maps. If you want to
do this, you can create your own offline map, getting
familiar with each gun or the gun you use most
often. This is the only true way to learn how to
control your gun. Typically, a burst fire method can
be used, which you adjust by range. For example,
with mid range shooting on the AK, I often shoot 3
shots and wait for about one shot between shooting
again. You have to give your gun enough time to
settle down. Some guns, however, have low kick
and you can shoot much longer before accuracy
goes down.

Quick Movements
You will learn many tricks while playing that allow
you to do things quickly. I will share a few with you.
My most used one is fast climbing ladders. This can
be accomplished by climbing a ladder sideways.
Instead of looking straight up jump onto the ladder
facing an angle up, but looking sideways and hold
down the up+strafe key. You should be strafing in
the direction of the wall. This might sound very
confusing, but you quickly understand what I mean
when trying it in game. Another trick is to practice
jump crouching into windows. If you run at a window
and click and hold to jump crouch, jump+crouch, you
can successfully pass right through the window
instead of having to slowly crouch walk through the
frame. I’m only giving you those two to get started.
Jump into the game and you will have a lot of fun
learning how to consistently improve your game
play.

Game Zone: Counter­Strike: Source (CS:S)
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by Darrel Johnston (djohnston)

Backup, backup, backup your personal files. Your vacation pictures, family tree
history files, the movie of your daughter’s graduation, financial spreadsheets and
digital art you created cannot be replaced if they are lost. Unless, of course, you
have backups. A backup program can be manually run by the user, but that
requires the discipline of the user remembering to run the backup. A backup
program can be scheduled to be run automatically. However, that means that any
new files written after the last backup can potentially be lost before the next
backup is scheduled to be run. Creating the backups takes extra disk space,
even if the disk space is part of an internet storage service.
With a RAID1 array setup, there is very little chance that you will ever lose your
data. That is because a RAID1 disk array is a mirrored setup. Anything written to
one disk or set of disks is also written to the mirrored disk or set of disks. So,
although you need at least one extra hard drive to set up the disk array, it is not
much different from needing extra disk space to store your program­created
backups. The advantage is that the backup files are created almost
instantaneously. With a two disk RAID1 setup, if one drive fails, the other one
keeps running. Once a replacement drive for the failed one is installed, the still
running drive synchronizes all its data to the new blank drive. After
synchronization is complete, the two drives begin reading and writing data in
tandem again.
Many of today’s motherboards come with RAID capabilities built into the board.
And, add­on RAID controllers can be bought for reasonable prices. In reality,
though, you do not need a hardware RAID controller in order to enjoy the benefits
of a RAID1 setup. You can control the RAID1 entirely with software from the
PCLinuxOS repositories. Although there may be a slight performance decrease in
using a software driven setup rather than a hardware driven one, the
performance loss won’t be very much. All you need are two matched hard drives
and the willingness to convert them into a RAID1 array.
What I mean by matched hard drives is that they should be close to equal in
capability. They do not have to be exact twins. The potential storage capacity of
the RAID1 array is only as large as the smallest drive in the array. And the
potential read and write speeds in the array are only as fast as the slowest drive
in the array. So, it is important to match the drives as closely as possible. You
would not want to use a 300GB drive with a 500GB drive because the total

capacity of the RAID1 array would be 300GB. The extra 200GB space on the
500GB drive would not be used. The read and write speeds should be close to
the same because the slower drive will cause unneeded wait times for the faster
drive.
Before beginning, be sure you have the following packages installed on your
system from Synaptic: dmraid, dmraid­events, libdmraid1 and mdadm. The setup
in this tutorial assumes that the user will use the RAID1 array as a data storage
device, and not as a home directory or root filesystem partition. I set up a
software RAID1 using two 10GB hard drives and started by creating sdb1 and
sdc1 partitions with fdisk.

Creating the RAID1 array
[root@localhost ~]# fdisk /dev/sdb
Command (m for help): nCommand actione extendedp primary partition (1­4)pPartition number (1­4, default 1): 1First sector (2048­20971519, default 2048):Using default value 2048Last sector, +sectors or +size{K,M,G} (2048­20971519, default20971519):Using default value 20971519
Command (m for help): tSelected partition 1Hex code (type L to list codes): fdChanged system type of partition 1 to fd (Linux raid autodetect)
Command (m for help): wThe partition table has been altered!
Calling ioctl() to re­read partition table.Syncing disks.[root@localhost ~]#

Create A Software RAID1
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[root@localhost ~]# fdisk /dev/sdc
Command (m for help): nCommand actione extendedp primary partition (1­4)pPartition number (1­4, default 1): 1First sector (2048­20971519, default 2048):Using default value 2048Last sector, +sectors or +size{K,M,G} (2048­20971519, default20971519):Using default value 20971519
Command (m for help): tSelected partition 1Hex code (type L to list codes): fdChanged system type of partition 1 to fd (Linux raid autodetect)
Command (m for help): wThe partition table has been altered!
Calling ioctl() to re­read partition table.Syncing disks.[root@localhost ~]#

Next, I created the RAID1 array using mdadm, then formatted /dev/md0 with the
xfs filesystem.
[root@localhost ~]# mdadm ­­create /dev/md0 ­­level=1 ­­raid­devices=2 /dev/sdb1 /dev/sdc1mdadm: array /dev/md0 started.[root@localhost ~]# mkfs.xfs /dev/md0meta­data=/dev/md0 isize=256 agcount=4,agsize=655292 blks= sectsz=512 attr=2,projid32bit=0data = bsize=4096 blocks=2621168,imaxpct=25= sunit=0 swidth=0 blksnaming =version 2 bsize=4096 ascii­ci=0log =internal log bsize=4096 blocks=2560,version=2= sectsz=512 sunit=0 blks, lazy­count=1realtime =none extsz=4096 blocks=0,rtextents=0[root@localhost ~]#

Then I checked the results by listing all drives with fdisk.
[root@localhost ~]# fdisk ­l
Disk /dev/sda: 8589 MB, 8589934592 bytes255 heads, 63 sectors/track, 1044 cylinders, total 16777216sectorsUnits = sectors of 1 * 512 = 512 bytesSector size (logical/physical): 512 bytes / 512 bytesI/O size (minimum/optimal): 512 bytes / 512 bytesDisk identifier: 0x00000000

Device Boot Start End Blocks Id System/dev/sda1 * 63 2088449 1044193+ 82 Linux swap/ Solaris/dev/sda2 2088450 16771859 7341705 83 Linux
Disk /dev/sdb: 10.7 GB, 10737418240 bytes107 heads, 17 sectors/track, 11529 cylinders, total 20971520sectorsUnits = sectors of 1 * 512 = 512 bytesSector size (logical/physical): 512 bytes / 512 bytesI/O size (minimum/optimal): 512 bytes / 512 bytesDisk identifier: 0x00000000

Device Boot Start End Blocks Id System/dev/sdb1 2048 20971519 10484736 fd Linux raidautodetect
Disk /dev/sdc: 10.7 GB, 10737418240 bytes107 heads, 17 sectors/track, 11529 cylinders, total 20971520sectorsUnits = sectors of 1 * 512 = 512 bytesSector size (logical/physical): 512 bytes / 512 bytesI/O size (minimum/optimal): 512 bytes / 512 bytesDisk identifier: 0x00000000

Device Boot Start End Blocks Id System/dev/sdc1 2048 20971519 10484736 fd Linux raidautodetect
Disk /dev/md0: 10.7 GB, 10736304128 bytes2 heads, 4 sectors/track, 2621168 cylinders, total 20969344sectorsUnits = sectors of 1 * 512 = 512 bytesSector size (logical/physical): 512 bytes / 512 bytesI/O size (minimum/optimal): 512 bytes / 512 bytesDisk identifier: 0x00000000

Create A Software RAID1
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Disk /dev/md0 doesn't contain a valid partition table[root@localhost ~]#
Notice the invalid partition table for /dev/md0. It doesn’t mean the device is
unusable. It simply means fdisk does not know how to deal with a RAID device.
Next, I made a mount point for md0, mounted it, checked the space on the drives,
then unmounted md0.
[root@localhost ~]# mkdir /mnt/raid1[root@localhost ~]# mount /dev/md0 /mnt/raid1[root@localhost ~]# df ­HFilesystem Size Used Avail Use% Mounted on/dev/sda2 7.4G 2.1G 5.0G 30% //dev/md0 11G 34M 11G 1% /mnt/raid1[root@localhost ~]# umount /mnt/raid1[root@localhost ~]#
I added one line to my /etc/fstab file:
/dev/md0 /mnt/raid1 xfs defaults 1 2
The mount point for md0 is /mnt/raid1. And sdb1, sdc1 and md0 look like the
following:

Create A Software RAID1
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I changed permissions on /mnt/raid1 to give all users full access.
[root@localhost ~]# chmod 777 ­R /mnt/raid1[root@localhost ~]# ls ­l /mnt | grep raid1drwxrwxrwx 2 root root 4096 Jun 29 03:49 raid1/[root@localhost ~]#
Just one more step to take. As root, edit the file /etc/mdadm.conf. The entire file
is commented, so I just added the line below to the bottom of the file.
ARRAY /dev/md0 devices=/dev/sdb1,/dev/sdc1 level=1 num­devices=2auto=yes
I created a desktop file on my LXDE desktop that I can click on to access the
contents of the RAID1 array. I also created a shortcut to the mountpoint on my
home directory by entering in a terminal:
[darrel@localhost ~]$ ln ­s /mnt/raid1 ~/RAID1
My desktop and home directory look like this:

The contents of the RAID1 desktop file are:
[Desktop Entry]Type=ApplicationIcon=/usr/share/icons/gnome/48x48/devices/drive­harddisk.pngName=RAID1Exec=pcmanfm /mnt/raid1StartupNotify=trueTerminal=falseMimeType=x­directory/normal;inode/directory;Encoding=UTF­8X­Desktop­File­Install­Version=0.11
So, we now have a RAID1 array set up. Whatever is written to /dev/sdb1 will also
be written to /dev/sdc1. To the system, both drives appear to be one unit,
/dev/md0. And /dev/md0 is mounted as /mnt/raid1 and has a volume label of
RAID1. But how can we be sure that both drives in the array are working? In a
terminal, run the command: cat /proc/mdstat
You will see something similar to the following:
Personalities : [raid1]md0 : active raid1 sdb1[0] sdc1[1]10484672 blocks [2/2] [UU]
unused devices: <none>
Replacing a failed drive and rebuilding the array
If you have a degraded RAID1 array, instead of the string [UU] you will see [U_].
If a disk has failed, you will probably find a lot of error messages in the log files
/var/log/messages and/or /var/log/syslog. Assuming that the log files show
/dev/sdc1 has failed, we must remove and replace it. We will use the mdadm
RAID management program for all steps. First, we have to mark /dev/sdc1 as
failed.
[root@localhost ~]# mdadm ­­manage /dev/md0 ­­fail /dev/sdc1
[root@localhost ~]#
Then we check the RAID1 status. /dev/sdc1 should have an (F) designation.
[root@localhost ~]# cat /proc/mdstatPersonalities : [raid1]md0 : active raid1 sdb1[0] sdc1[1](F)10484672 blocks [2/1] [U_]unused devices: <none>[root@localhost ~]#
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Next we need to remove /dev/sdc1 from /dev/md0:
[root@localhost ~]# mdadm ­­manage /dev/md0 ­­remove /dev/sdc1mdadm: hot removed /dev/sdc1[root@localhost ~]#
When we check the RAID1 status again, /dev/sdc1 should not be listed.
[root@localhost ~]# cat /proc/mdstatPersonalities : [raid1]md0 : active raid1 sdb1[0]10484672 blocks [2/1] [U_]
unused devices: <none>[root@localhost ~]#
Once the failed drive has been logically removed from the software RAID
controller, it is time to shut down the computer, physically remove the drive and
replace it with another.
[root@localhost ~]# shutdown ­h now
After you have replaced the failed hard drive and rebooted the computer, you can
easily duplicate the partitioning scheme of the still running drive with just one
command:
[root@localhost ~]# sfdisk ­d /dev/sdb | sfdisk /dev/sdc
Run fdisk ­l as root to check that both drives have the same partitioning. Next we
need to add /dev/sdc1 to /dev/md0.
[root@localhost ~]# mdadm ­­manage /dev/md0 ­­add /dev/sdc1mdadm: re­added /dev/sdc1[root@localhost ~]#
Now the array /dev/md0 will be synchronized. Run cat /proc/mdstat to see when
it's finished. During the synchronization the output will look like this:
[root@localhost ~]# cat /proc/mdstatPersonalities : [raid1]md0 : active raid1 sdb1[0] sdc1[1]10484672 blocks [2/1] [U_][=>...................] recovery = 19.9%(2414398/10484672) finish=1.4min speed=126519K/sec
Once the synchronization has completed, the RAID1 array will again look like the
following.

[root@localhost ~] cat /proc/mdstatPersonalities : [raid1]md0 : active raid1 sdb1[0] sdc1[1]10484672 blocks [2/2] [UU]
unused devices: <none>[root@localhost ~]
Answers to
Mark Szorady's
Double Take:
(1) Spot missing from dog's
back; (2) Man's hair different;
(3) Computer screen larger;
(4) Seat back lower; (5) Man's
arm different; (6) “Now” added
to word balloon; (7) Shirt
button missing
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by Meemaw
Last time we learned about the toolbox and the color
chooser in Gimp, and started a drawing. Mine is
shown below.

However, we never talked about the tools in the
right­hand window. If you haven’t closed that
window, the first thing you will see is the Layers
toolbox.

When I first started using
the Gimp, I didn’t use
layers, but as I’ve learned
more about Gimp, I have
found that layers are very
useful. You can use as
many layers as you want
to make your drawing, and
reorder the layers any way
you desire. Using different
techniques on the layers
can make your finished
product look different than
it would if it was all on one
layer. Also, when one layer
is finished the way you

want it, you can do whatever you want to another
layer without disturbing anything else. The tools
across the bottom of the window are, from left to

right, New Layer, Raise Selected Layer, Lower
Selected Layer, Duplicate Layer, Anchor Layer and
Delete Layer.
When you started your drawing, it had only one layer
(called Background). In the layers window, click the
New Layer button (the button at bottom left that
looks like a piece of paper with the plus sign on one
corner). A window will appear asking you to name
your layer, designate how big you want it and
whether you want it white, black or transparent
(choose transparent because you want the face to
show through). If you don’t give it a new name, a
new entry, called New Layer, will appear in the list
above the Background. You’ll notice now that many
of the tools I just named are active.

You may also notice that
your drawing appears in
the Background icon in
the Layers window. This is
done to help you stay
organized, so you can
choose the correct layer
when you want to work on
another one. If you didn’t
name your layer before
you created it, you can
right­click and choose
“Edit Layer Attributes”
from the menu, and
rename it with a more
meaningful name. Let’s
name it “Bow”.

Choose a color you like and draw a bow on this
layer. If your “person” is a man, it can be a bow­tie,
and if it’s a girl, you could put it in her hair. It’s your
drawing, so do whatever you want. You can even put
it out to one side of the face, as we can move it

around later.
Now, instead of choosing the bucket fill, we’re going
to do something a little different. Bucket fill often
leaves unfilled areas. Choose the Free Select tool
(looks like a lasso) and trace around one part of your
bow. Click inside the colored line you already made
and make segments until you have closed your
curve. Every place you click will leave a small circle.
But when your curve is closed, it will look like a
moving dotted line instead. Now choose your bucket
fill and fill your bow. Click on the color you have
already drawn and then click inside. It should fill
properly. Looking at the shot below, you can see the
difference. The top was bucket fill only ­ the bottom
is bucket fill after the free select. After this, I will
outline the top bow with the Rectangle Select tool
and delete that one because I don’t want it.

Since we have our bow on another layer, we can
rotate it or move it anywhere we want. Using the
Move tool (4­pointed arrow) and putting your cursor
on the bow, you can move the layer around as you

Graphics Tutorials: GIMP, Part 2



PCLinuxOS Magazine Page 29

wish. I put mine below my face. You can see the
layer boundary on the drawing.

Sometimes you want things rotated. I want the bow
in a different position, so I’m going to choose the
Rotate tool (looks like 2 sheets of paper with curved

arrows around them). When you click on it and then
on the bow, a window will pop up with the rotate
tools. You will see a circle with a plus sign inside.
That is the rotation axis, and you should click and
drag it to wherever you want as the center of
rotation. I dragged mine to the center of the bow,
then in the rotation window, clicked the arrow next to
the degrees to change the angle of the bows. As the
degrees get larger your bow will rotate clockwise,
and the larger negative degrees will rotate counter­
clockwise. Rotate it however you want it, then click
“Rotate” in the tool window (below). Before and after
views will show up, which is why my bow now looks
like it has four points on each end.
When you get it the way you want it, choose another
tool to keep the Rotate tool window from popping up
again. Make sure you save your drawing when you
have it as you want it.
I should note that this particular rotation method is
different than the method you would use to rotate a

picture. It can be
used, but the
rotation commands
under the
"Transform" menu
item are easier to
rotate an entire
image.
Next time, we’ll add
more to our
drawing.

International CommunityPCLinuxOS Sites

Netherlands

Turkey

Denmark
Czechoslovakia

Italy

Poland

Brazil
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by Patrick G Horneker (phorneker)
As we saw in the last article on QEMU, we can run
FreeDOS in QEMU and configure QEMU to emulate
some hardware components when running
FreeDOS. We already know how to transfer files
between the QEMU disk image and PCLinuxOS by
mounting the disk image.
We can already print from DOS applications by
redirecting output to a disk file on PCLinuxOS.
Finally, we have created a shell script to start QEMU
without having to type a list of configuration options,
namely:
#!/bin/bashqemu ­fda floppies/blankfloppy.img­hda freedos.img ­cdromiso/fdsrc11.iso ­boot c ­m 32 ­soundhwsb16 ­serial /dev/ttyACM0 ­parallelfile:printer0.ps
To get the most out of QEMU, we need to configure
the networking capabilities of QEMU.
The ­device Option
QEMU will give you a list of all emulated hardware
by typing qemu ­device ? in a terminal window, and
get the following:
[patrick@localhost ~]$ qemu ­device ?Could not initialize KVM, will disableKVM supportname "virtio­9p­pci", bus PCIname "virtio­balloon­pci", bus PCIname "virtio­serial­pci", bus PCI,alias "virtio­serial"name "virtio­net­pci", bus PCIname "virtio­blk­pci", bus PCI, alias"virtio­blk"name "smbus­eeprom", bus I2C

name "scsi­disk", bus SCSI, desc"virtual scsi disk or cdrom"name "scsi­generic", bus SCSI, desc"pass through generic scsi device(/dev/sg*)"name "usb­hub", bus USBname "usb­host", bus USBname "usb­kbd", bus USBname "usb­mouse", bus USBname "usb­tablet", bus USBname "usb­storage", bus USBname "usb­wacom­tablet", bus USB, desc"QEMU PenPartner Tablet"name "usb­braille", bus USBname "usb­serial", bus USBname "usb­net", bus USBname "usb­bt­dongle", bus USBname "virtconsole", bus virtio­serial­busname "virtserialport", bus virtio­serial­busname "ioh3420", bus PCI, desc "IntelIOH device id 3420 PCIE Root Port"name "x3130­upstream", bus PCI, desc"TI X3130 Upstream Port of PCI ExpressSwitch"name "xio3130­downstream", bus PCI,desc "TI X3130 Downstream Port of PCIExpress Switch"name "isa­serial", bus ISAname "isa­parallel", bus ISAname "vt82c686b­usb­uhci", bus PCIname "piix4­usb­uhci", bus PCIname "piix3­usb­uhci", bus PCIname "sysbus­ohci", bus System, desc"OHCI USB Controller"name "pci­ohci", bus PCI, desc "AppleUSB Controller"name "SUNW,fdtwo", bus Systemname "sysbus­fdc", bus Systemname "i6300esb", bus PCI

name "ne2k_pci", bus PCIname "i82801", bus PCI, desc "Inteli82801 Ethernet"name "i82562", bus PCI, desc "Inteli82562 Ethernet"name "i82559er", bus PCI, desc "Inteli82559ER Ethernet"name "i82559c", bus PCI, desc "Inteli82559C Ethernet"name "i82559b", bus PCI, desc "Inteli82559B Ethernet"name "i82559a", bus PCI, desc "Inteli82559A Ethernet"name "i82558b", bus PCI, desc "Inteli82558B Ethernet"name "i82558a", bus PCI, desc "Inteli82558A Ethernet"name "i82557c", bus PCI, desc "Inteli82557C Ethernet"name "i82557b", bus PCI, desc "Inteli82557B Ethernet"name "i82557a", bus PCI, desc "Inteli82557A Ethernet"name "i82551", bus PCI, desc "Inteli82551 Ethernet"name "i82550", bus PCI, desc "Inteli82550 Ethernet"name "pcnet", bus PCIname "e1000", bus PCI, desc "IntelGigabit Ethernet"name "rtl8139", bus PCIname "ne2k_isa", bus ISAname "ide­drive", bus IDEname "isa­ide", bus ISAname "ich9­ahci", bus PCI, alias"ahci"name "lsi53c895a", bus PCI, alias"lsi"name "VGA", bus PCIname "vmware­svga", bus PCIname "sb16", bus ISA, desc "Creative
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Sound Blaster 16"name "ES1370", bus PCI, desc "ENSONIQAudioPCI ES1370"name "AC97", bus PCI, desc "Intel82801AA AC97 Audio"name "intel­hda", bus PCI, desc "IntelHD Audio Controller"name "hda­duplex", bus HDA, desc "HDAAudio Codec, duplex"name "hda­output", bus HDA, desc "HDAAudio Codec, output­only"name "cirrus­vga", bus PCI, desc"Cirrus CLGD 54xx VGA"name "isa­applesmc", bus ISAname "ib700", bus ISAname "isa­debugcon", bus ISAname "testdev", bus ISA
As we can see here, QEMU provides a lot of
hardware options, many of which we already
discussed, and some of these are not relevant to
FreeDOS (because some devices shown here were
never supported by any version of DOS).

Network Adapters Emulated by QEMU
Let us open a terminal window. We can find out
which network adapters QEMU can emulate when
running as an x86 machine. We could type qemu
­net nic,model=? and get a list of supported
network adapters, but the developers of QEMU
deprecated the ­net option. We can use it now, but
it may no longer work in a future version of QEMU.
As we saw in the above listing, QEMU supports the
following network adapters, with the QEMU device
name in bold:
Novell NE2000 PCI (ne2k_pci)
Novell NE2000 ISA (ne2k_isa)
Realtek 8139 (rtl8139)
AMD PCFastIII (pcnet)
Intel E­1000 (e1000, This is the QEMU default)
Intel i82801 (i82801)

Intel i82562 (i82562)
Intel i82559a (i82559a)
Intel i82559c (i82559b)
Intel i82559c (i82559c)
Intel i82559er (i82559er)
Intel i82558a (i82558a)
Intel i82558b (i82558b)
Intel i82557a (i82557a)
Intel i82557b (i82557b)
Intel i82557c (i82557c)
Intel i82550 (i82550)
Intel i82551 (i82551)
Only the ne2k_isa is an emulated ISA adapter. All
other adapters are for the emulated PCI bus, so we
need to keep this in mind when finding DOS drivers
for these adapters.

Where to get DOS drivers:
Crynwr Software (http://www.crynwr.com/drivers/)
provides DOS drivers for some of these devices.
The file 00index.html contains descriptions of each
of the driver files available for download. A file
called many­other­drivers.zip contains a driver for
the NE2000 adapters.
In the last article, I showed you how to mount the
QEMU disk image. After downloading the driver
files, you will need to mount the disk image (to
/mnt/freedos) and transfer the downloaded files so
FreeDOS can use them.
Georg Potthast has a collection of packet drivers
that can be used on FreeDOS. There are drivers for
the Realtek 8139, the Novell NE2000 and the Intel
e1000. It would also be a good idea to download
NICSCAN.EXE so FreeDOS can detect the
emulated network card.
Note: AMD’s PCFastIII requires a driver for the AMD
79C973 chipset. This is not the same as the
79C970, which is in the PCFastII, an ISA based
network adapter.

Intel has a downloadable DOS driver for the E1000
on their website. On that page, you want to click on
PRODOS.EXE, then click on Download from the
next page that appears. Agree to the license, and
then download the file. If you are using Firefox, be
sure to choose Save File when the dialog box
appears asking you what to do with the file.

Let’s Get a TCP/IP Driver for FreeDOS
Besides the network driver, we will need to get a
TCP/IP driver for FreeDOS. There is a 16­bit
TCP/IP stack Novell developed for its Netware
products that allows ODI drivers to use TCP/IP. It
can be downloaded from bbs.actapricot.org.

Now Let’s Get The Driver into FreeDOS
There are two ways to get the driver file into
FreeDOS. If you have a floppy drive on your
system, you may write that file to the floppy, then
use that floppy when running FreeDOS.
If no floppy drive is present, we can mount the
QEMU disk image to PCLinuxOS and transfer the
network driver file to drive C: on the disk image.
For this disk image, we shall use the QEMU default,
an emulated Intel Pro E1000 adapter. Open a
terminal, login as root, and type in the following:
mkdir ­p /mnt/freedosmount ­o loop,offset=32256/home/patrick/vm/freedos.img/mnt/freedoscp /home/patrick/Downloads/PRODOS.EXE/mnt/freedoscp /home/patrick/Downloads/tcp16.exe/mnt/freedosumount /mnt/freedos
Of course, your home directory will differ from the
example. Now, when we launch QEMU, the driver
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file will be in drive C:, which is where we will be after
FreeDOS boots.
If you choose the many­other­drivers.zip then you
would emulate a Novell NE2000 ISA adapter. In this
case, we would type this:
mkdir ­p /mnt/freedosmount ­o loop,offset=32256/home/patrick/vm/freedos.img/mnt/freedoscp /home/patrick/Downloads/many­other­drivers.zip /mnt/freedosumount /mnt/freedos
Edit ~/bin/freedos
Let us now open the freedos file we created from
the last article. We will need to add some
parameters to add network support to our QEMU
session.
#!/bin/bashqemu ­fda floppies/blankfloppy.img­hda freedos.img ­cdromiso/fdsrc11.iso ­boot c ­m 32 ­soundhwsb16 ­serial /dev/ttyACM0 ­parallelfile:printer0.ps
For the emulated Intel E1000 adapter, we need to
add the following:
­netdev user,id=usernet ­device
e1000,netdev=usernet
This is inserted into the file after the ­soundhw and
before the ­serial and/or ­parallel parameters.
Hence, our file should read as follows:
#!/bin/bashqemu ­fda floppies/blankfloppy.img­hda freedos.img ­cdromiso/fdsrc11.iso ­boot c ­m 32 ­soundhwsb16 ­netdev user,id=usernet ­devicee1000,netdev=usernet ­serial

/dev/ttyACM0 ­parallelfile:printer0.ps
If you plan to emulate a Novell NE2000 ISA board,
we need to add the following:
­netdev user,id=usernet ­device
ne2k_isa,irq=5,netdev=usernet
Our file should then read as follows:
#!/bin/bashqemu ­fda floppies/blankfloppy.img­hda freedos.img ­cdromiso/fdsrc11.iso ­boot c ­m 32 ­soundhwsb16 ­netdev user,id=usernet ­devicene2k_isa,irq=5,netdev=usernet ­serial/dev/ttyACM0 ­parallelfile:printer0.ps
Save the file and run freedos. When FreeDOS
starts up, type dir to verify that the driver has been
transferred to the disk image.

Success. The file called PRODOS.EXE contains the
driver files for the E1000 network card.
Now, let us create a directory to unpack the
executable. For this article, let us call this directory
E1000 for the name of the emulated network card.

So, we type the following lines:
mkdir e1000
copy prodos.exe e1000
cd e1000
...and we should see the following:

Though PRODOS.EXE is a self extracting file, it
cannot be extracted from within FreeDOS. This file
was intended to be self extracted from Windows.
Fortunately, this file will extract with unzip.
Hence, we will need to type in unzip prodos.exe.
We get the following:

The file we want is called e1000odi.com and it is
located in C:\E1000\PRO1000\DOS. Also, there is a
file called readme.txt. Let us read this file using
EDIT (next page).
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Answer Yes to this question as it is typical in DOS
text files for an indent to be equivalent to eight
spaces.
This file is a set of release notes for the driver
intended to be used on Windows and OS/2.
Scrolling down this list reveals a list of supported
network adapters.

Notice that this driver set also supports the i82562
device, not just the e1000, so we could substitute
i82562 for e1000 in the QEMU parameters for
networking.
...and here are the release notes for using the
i82562 device with the e1000 drivers (center top).
We can also use any of the i82598 and i82599
devices mentioned earlier as well. Here are the
notes regarding the use of these devices.

Select File, then Exit to exit the editor. Now type cd
pro1000\dos to get to the directory where the driver
is located.

Type e1000odi, then type lsl. The network driver
will load.

The second command (lsl) verifies that the driver
has been loaded. Let us take a look at net.cfg in
this directory.

We just got the emulated Intel E1000 working. Now,
how do we get the driver to load when we start
FreeDOS? By editing C:\AUTOEXEC.BAT.
Type the following:
cd c:\
edit autoexec.bat
(Image top, next page)
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Now we scroll through this file.

Scrolling to the end of the file shows the following:

Now, we need to find a spot to insert the command
to load the e1000 driver. We scroll back to the

beginning of the file. A good place to insert the
command is after the LH DOSLFN command as
highlighted below:

Place the cursor after the highlighted line, and press
Return to insert a blank line below. Now type
C:\E1000\PRO1000\DOS\E1000ODI and save the
file. Select File, then select Save (or simply press
Control­S) to save AUTOEXEC.BAT.

Now exit the editor. We now have the E1000 driver
configured for FreeDOS. Next, type cp tcp16.exe
c:\e1000 to get the TCP/IP driver into the directory
where the E1000 driver has been installed.
Besides the Novell client, Microsoft has a DOS
Client available for download that provides TCP/IP
as well as the NetBEUI service.

If you choose to use many­other­drivers.zip
An alternate configuration for QEMU is to configure
networking to emulate a Novell NE2000 (the
ne2k_pci and ne2k_isa devices). If you do this,
you will not need the Novell TCP/IP packet driver as
many­other­drivers.zip contains TCP/IP built in to the
driver.

The many­other­drivers.zip appears here as MANY­
O~1.ZIP. This is due to the limitations of the FAT16
filesystem, which does not support long filenames
when running DOS. Create a directory called
CRYNWR to store the drivers for this file. Copy
MANY­O~1.ZIP to CRYNWR. Then CD CRYNWR
and then UNZIP MANY­O~1.ZIP to unpack the files.
To activate the TCP/IP Driver, type:
ne2000 0x60 0x05 0x300
and you should have a working TCP/IP connection
with a MAC address. The first parameter should be
a hexadecimal value from 0x60 through 0x66, 0x68
through 0x6F, or 0x78 through 0x7E. These are
interrupt vectors available to network cards running
under DOS.
The second parameter is the Interrupt Request
(IRQ) for the network card itself. I recommend 0x05
for this to work under QEMU as we specified this in
the freedos batch file.
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The third parameter is the I/O address assigned to
the network card. For QEMU, this is 0x300. We can
change this in the freedos batch file by adding the
io= parameter to the ­device parameter we
specified for the network card.
We need to edit AUTOEXEC.BAT so it reads as
follows:

Reboot FreeDOS, and we should get a working
TCP/IP connection.

The presence of NE2000 in the modules list
indicates that the packet driver is available and
working.
If you want DHCP service, type DHCP to get an IP
address. By default, QEMU uses a bridged network,
that is, QEMU shares the same Internet connection
with the PCLinuxOS host. This may or may not be
what you want.

Here, FreeDOS is sharing the Internet connection
with PCLinuxOS.

Other Packages Required on the PCLinuxOS
Side
Besides the QEMU packages, qemu and qemu­
tools, there are some other packages that need to
be installed from Synaptic on PCLinuxOS.
ipxutils: This is used to configure IPX interfaces on
PCLinuxOS (especially if you plan to use ODI drivers
in QEMU).
libncpfs: This library handles Novell Netware
filesystems on PCLinuxOS.
vde: This is Virtual Distributed Ethernet, the
mechanism that makes communication between
actual PCLinuxOS machines and virtual machines
(such as QEMU and VirtualBox) possible.
Also, if you are planning to use NetBEUI, you will
need at least the samba packages. The easiest
way to accomplish this is to install the task­samba
metapackage in Synaptic.
As for the Microsoft client, that client is no longer
publicly available.

It's easier than E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...
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Screenshot ShowcaseScreenshot Showcase

Support PCLinuxOS! Get Your Official
PCLinuxOS
Merchandise Today!

Posted by zakoz, July 23, 2012, running KDE 4.
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by T6

I don't like to use Google as my default search
engine. It is good, but sometimes it doesn't do what I
need. I used to work with metacrawler, until I
abandoned Firefox. In Opera, I couldn't find a way
to add metacrawler directly. That is, until I found the
steps required to do it.
First, open Opera web browser.
Second, in the address bar enter the address of the
search page you prefer. In my case, I entered
www.metacrawler.com.
Third, right click on the search box, then select
“Create Search...”

Fourth, in the search engine window you can assign
a name for the new search engine, a keyword, mark
“Use as default search engine” to replace Google or
your current search engine, and “Use as speed dial

search engine.”

Just mark what you need, and press OK.
Don't modify the address, or the new search
engine will not work.
If you marked “Use as default,” the new search
engine should be immediately available.

I tried this process with Bing, Yahoo, Google, and
Ask, among others, and it worked well.

Customize Your DefaultSearch Engine In Opera
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by longtom & longtomjr

I have an oldish PC. Ok – it's an old brick. I know, I
know. That means that downloading videos from the
popular hosting sites like YouTube always meant
use of quite a lot of resources. So, I was browsing

around for a program that could do this cheaply in a
terminal. I found youtube­dl.
I tried it and it worked very well. I figured out how to
make sure the resolution I like is downloaded, the
file name is the way I want it. etc.

Longtomjr felt it would be a lot cooler to make this
easier to use with a bash script and zenity.
So this is what you need to do.
Download youtube­dl from here. Right click on the
date and choose "Save Link As..." This will give you
the most up­to­date version of youtube­dl, which is a
Python script with no external dependencies
(making it safe to use on your system, without fear of
borking your installation).
Meanwhile, download longtomjr’s custom bash
script, Youdl.sh, from here, or enter the following in
your favorite text editor (saving it as youdl.sh):
#!/bin/bash
cd ~/Downloads
szAnswer=$(zenity ­­entry ­­text "EnterLink" ­­entry­text "link"); echo $szAnswer
szReso=$(zenity ­­list ­­text "ChoseResolution" ­­radiolist ­­column "Pick" ­­column "Resolution" False "720" True "480"FALSE "360" FALSE "240");echo $szReso
szSavePath=$(zenity ­­file­selection ­­directory);echo $szSavePathcd $szSavePath
if [ $szReso == 720 ]then~/bin/youtube­dl.py ­l ­f 45 $szAnswerfi
if [ $szReso == 480 ]then~/bin/youtube­dl.py ­l ­f 35 $szAnswerfi

Download YouTube Videos The Light Way

http://rg3.github.com/youtube-dl/download.html
http://dl.dropbox.com/u/14146186/Youdl.sh
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if [ $szReso == 360 ]then~/bin/youtube­dl.py ­l ­f 34 $szAnswerfi
if [ $szReso == 240 ]then~/bin/youtube­dl.py ­l ­f 5 $szAnswerfi
zenity ­­info ­­text "Session complete,press ok"

Create a folder /home/you/bin, and copy youtube­dl
and Youdl.sh into /home/you/bin. Be sure that both
files are marked to be run as an application.
At that point, I renamed youtube­dl to youtube­dl.py
Run Youdl.sh in a terminal. It will run without a
terminal, but then you can't see the progress.
We decided to make a .desktop file in order to have
it in the menu (PCLinuxOS LXDE).
If you would like something similar, here is the
.desktop file. Alternatively, you can enter the
following in your favorite text editor, and save it as
YouTubeLight.desktop (or any other name that you
wish to call it).
[Desktop Entry]Name=YouTube downloaderGenericName=Download ManagerComment=Simple Youtube Download ManagerExec=/home/longtom/bin/Youdl.shIcon=/home/longtom/icons/YT_download.pngEncoding=UTF­8Version=0.1Type=ApplicationTerminal=trueStartupNotify=falseCategories=Utility;X­MandrivaLinux­System­FileTools;

Replace the red text with your username, and save it
in /home/you/.local/share/applications/. (Thanks,
Leiche!)
That's where we called it a day. It does what we
wanted and then some. Maybe you will find some
use for it, too.
We found that it works with:
YouTube.com.
YouTube.com playlists (playlist URLs in
"view_play_list" form).
YouTube.com searches, using the special
keyword "ytsearch" as a form of URL, as in
"ytsearch:cute kittens". Do not forget the quotes
if you want to include spaces in your search.
Other variants are "ytsearchN" to download
more than the first result, with N being a number,
and "ytsearchall".
YouTube.com user videos, using user page
URLs or the specifc "ytuser" keyword.
metacafe.com.
Google Video.
Google Video searches ("gvsearch" keyword).
Photobucket videos.
Yahoo! video.
Yahoo! video searches ("ybsearch" keyword).
Dailymotion.
DepositFiles.
blip.tv.
vimeo.

myvideo.de.
The Daily Show/Colbert Nation.
The Escapist.
A generic downloader that works in some sites.

There you go! Now you can join me and Junior in
downloading YouTube videos (and videos from other
streaming sites) the light way.

Looking for an old article?Can't find what you want? Try the

PCLinuxOS Magazine'ssearchable index!

Download YouTube Videos The Light Way

http://www.enkiconsulting.net/
http://pclosmag.com/html/sorted.html
http://dl.dropbox.com/u/14146186/Youdl.desktop
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by longtomjr

“Asunder is a graphical Audio CD ripper and
encoder for Linux. You can use it to save tracks from
an Audio CD as any of WAV, MP3, OGG, FLAC,
WavPack, Musepack, AAC, and Monkey's Audio
files.” ~ Asunder official website
Asunder is surely a nifty, light and simple tool with a
lot of features. As mentioned above, it can rip your
CDs to almost any format. Another plus point is that
it has a CDDB lookup integrated, so you can just
insert your CD – wait for a couple of seconds, and
voila – you have all your CD's info. Now you just go
ahead and rip it.
In the Preferences menu you can choose a lot of
stuff. Example: create M3U playlist, your destination
folder, your format and some other settings for the
brave. Just a little warning. When you choose your
format, make sure you don't have two formats
selected. This happens to me all the time ­ unless
you want to.
Just a two more notes:
To rip to MP3s, you will need Lame installed from the
package manager.
Always make sure of your settings before you rip.
You don't want your AACs in your bin directory.
Have fun ripping with Asunder!

Asunder: A Brief Review

Visit Us On IRC
• Launch your favorite IRC Chat Client software
(xchat, pidgin, kopete, etc.)

• Go to freenode.net

• Type "/join #pclosmag"
(without the quotes)

PCLinuxOS Magazine Mailing List:
http://groups.google.com/group/pclinuxos­magazine

PCLinuxOS Magazine Web Site:
http://pclosmag.com/

PCLinuxOS Magazine Forums:
http://www.pclinuxos.com/forum/index.php?board=34.0

Reach Us On The Web

http://groups.google.com/group/pclinuxos-magazine
http://pclosmag.com
http://www.pclinuxos.com/forum/index.php?board=34.0
http://ge.tt/9twFf7A?c
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Reprinted from April 2010 MP3 OGG

ms_meme's Nook Reprise:Vim Viminey Vim Viminey Vim Vimveree

viminey viminey vimveroo
Hear what I tell you it is all true

viminey viminey vimveree
is lucky you will agree

And best of all is free

viminey viminey vimveree
I am as lucky as lucky can be

viminey viminey vimveroo
I use to make songs for you
Come everyone try too

viminey viminey vimveree
If you want luck do just like me

viminey viminey vimveroo
Open a konsole it's not hard to do
Start using you'll be lucky too

http://www.pclosmag.com/html/Issues/201004/files/vim15.mp3
http://www.pclosmag.com/html/Issues/201004/files/vim15.ogg
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Screenshot ShowcaseScreenshot Showcase
LinPC.us

Posted by RobNJ, July 10, 2012, running e17.Available in the following desktops:
KDE LXDE Xfce
Openbox Gnome
Enlightenment e17

http://www.linpc.us
http://www.pclinuxos.com
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by Paul Arnote (parnote)

If you happen to run the KDE version of PCLinuxOS,
whenever you click on a PDF, the file opens in an
embedded Okular window inside of Firefox. But what
if you are running the E17, LXDE, Xfce, Gnome or
Openbox desktop? Surely you won’t be too crazy
about installing Okular, which brings in most of KDE
with it, along with all of its Qt4.x dependencies. To
do that, you might as well just install KDE.
Fortunately, there IS another alternative. Thanks to
mozplugger (in the PCLinuxOS repository), you can
have Firefox open PDFs in an Evince window
embedded right in Firefox. Yep. That’s right. Any
PDF file you click on will open in a new tab,
populated with the PDF file displayed in an
embedded Evince window (with one exception,
which we’ll cover later).

How It Works
The whole process of setting this up is easy. First,
search for and install mozplugger from the
PCLinuxOS repository.
Next, open your terminal program and type the
following at the command prompt (all on one line):
mousepad /home/YourUsernameHere/.mozilla/mozpluggerrc
Replace “mousepad” with your favorite text editor
(leafpad, gedit, geany, etc.), and replace
“YourUsernameHere” with the login name you used
when you signed into your session. Since we’re
using the command line, you can also replace
“/home/YourUsernameHere” with ~.

Now, enter the following lines into your text editor:
application/pdf: pdf: PDF fileapplication/x­pdf: pdf: PDF filetext/pdf: pdf: PDF filetext/x­pdf: pdf: PDF fileapplication/x­postscript: ps: PostScriptfileapplication/postscript: ps: PostScript file

repeat noisy swallow(evince) fill:evince "$file"
Save the file (just select File > Save and the file will
be written to the location you specified on the
command line), and restart Firefox.

July 2012 issue of The PCLinuxOS Magazine displayed in Firefox, inside an embedded Evince window.

Embed PDFs In FirefoxWith Evince Via Mozplugger
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When Firefox has restarted, go find a PDF file on the
web (that shouldn’t be too hard) and click on it. If
you did everything properly, you should see the PDF
file open in the current tab in Firefox, displayed in an
embedded Evince window.

Caveats & Customization
Take note that the magazine PDF downloads will not
work using this method, since the download of those
files are managed by a *.php script on the magazine
web site. In fact, any PDF download managed by a
*.php script will bypass Mozplugger. However, once
you’ve downloaded the magazine PDF, you can
select File > Open File..., then select the magazine
PDF file you just downloaded. The magazine PDF
will then open in the current tab in Firefox. Of
course, it is just as easy to open the PDF file (at that
point) in Evince’s own window.
When you installed mozplugger via Synaptic, a
default mozpluggerrc file was also installed to your
/etc folder. Mozplugger will use the first
mozpluggerrc file it finds, looking first in the .mozilla
directory in your /home folder, then in a series of
other folders in your path. To see the list, along with
the order of directories it searches for the
mozpluggerrc file, type man mozplugger at the
command line. As an insurance policy, a backup
mozpluggerrc file is also installed to your /etc
directory, named mozpluggerrc.default.
While you could edit the mozpluggerrc file in /etc
(you can only edit it as the root user), I think it’s safer
to simply create and edit the mozpluggerrc file in
your .mozilla folder. It does not require root access
to edit, and if you mess things up, you can always
just delete it and start over, without fear of losing any
functionality. Go ahead and take a look at the
mozpluggerrc file in your /etc folder. If you see some
functionality you’d like to enable (such as viewing
LibreOffice files right in Firefox), copy that section of
the mozpluggerrc file in /etc and paste it into the

mozpluggerrc file in the .mozilla directory in your
/home directory.
Also, if you prefer to use a different PDF viewer than
Evince (such as xpdf or epdfview), replace “(evince)”
in the last line of the above entry in the
mozpluggerrc file with the name of your preferred
PDF viewer. Again, check the mozpluggerrc file in
your /etc directory for specific examples.
Say you had mozplugger handling the opening of
certain file types, but now you want to prevent
mozplugger from opening them. Just as easily as
you created the mozpluggerrc file, you can edit it to
exclude them from having mozplugger handle them.
Simply find the relevant section in the mozpluggerrc
file and place a # in front of each line related to that
file type. The # at the beginning of the line causes
mozplugger to treat the line as a comment, and it
skips those lines. This way, if you ever want to
change back to having mozplugger handle the
display of those file types, you only have to remove
the #, re­save the mozpluggerrc file, and restart
Firefox.

Summary
If you do everything correctly, mozplugger can add a
lot of convenience and functionality to Firefox,
enabling it to display file types right in its own tabs
that you would otherwise have to open in a separate
application window. Mozplugger can add a lot of
power to an already powerful Firefox.

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com
We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

Summer Fairy
Edition

Black Myst
Edition

Barebones
Laptop Edition

Want To Help?
Would you like to help with the PCLinuxOS
Magazine? Opportunities abound. So get
involved!
You can write articles, help edit articles, serve
as a "technical advisor" to insure articles are
correct, create artwork, or help with the
magazine's layout.
Join us on our Google Group mailing list.

The PCLinuxOS Magazine
Created with Scribus 1.3.9

Embed PDFs In Firefox With Evince Via Mozplugger

mailto:pclinuxos.mag@gmail.com
http://csolisphotography.com/iso/Updated-SF-E17.iso
http://csolisphotography.com/iso/E17-BlackMyst.iso
http://csolisphotography.com/iso/barebones-laptop.iso
http://groups.google.com/group/pclinuxos-magazine
http://www.opensource.org/
http://www.scribus.net
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Never Fails to Amaze Me
by plankton172

Yesterday, I bought a drawing tablet for my 13­yr old
son: a Genius F509. I initially contemplated on
getting the more expensive Wacom Bamboo, but
since this is the first pen tablet he's use, we'll find out
first if this model will do until we see the need to
upgrade. I got home and booted the desktop PC to
Win7 and installed the tablet (it required the driver
on the included CD­ROM to properly install). I tested
it on GIMP, and it was okay. I restarted the PC and
booted to PCLinuxOS. Without installing anything, I
tested the tablet on GIMP. Lo and behold – not only
did it work out­of­the­box, the pen tablet even
seemed more responsive than it was while running
in Win7! This OS just hits one home run after
another! How can I say that? It's because it's the
same with my iPod, Kindle, Novo7 Android tablet,
Panasonic digicam, Samsung cellphone ... it
recognizes virtually all external devices I plug into it.
Everything not only works, it makes working with
gadgets even better and way smoother.
It's actually been more than a year since I first tried
PCLinuxOS. At first, I thought it was just going to be
my "backup" OS. It only took a few weeks before I
realized it's more appropriate to make it my *main*
OS. I actually want to make it my *only* OS, if not for
my wife and son who still need Win7 for a few things
to be done.
I guess there is little to say about PCLinuxOS that
hasn't been said already. It's (radically) simple to
install, maintain and use. There is a little bit of a
learning curve, but it is not very steep. The forum
and magazine are extremely useful in getting info
and help. Were they not, then I don't think I would be
using this for so long.

I have only one nagging problem on my desktop PC
install which I have never quite solved 100%. I
suspect it involves flash and/or the video card
drivers, but I will post that matter in the proper
section.
Until then, thank you and MABUHAY, PCLinuxOS!

One of a Kind
by andy

To all involved with the creation and support of
PCLinuxOS and to anyone thinking of going this OS
route,
Due to work taking most of my time, I had strayed
away from Linux for about 3+ years until the spring
of 2011 or so. My last Linux install had been RHL
v.8, and I liked it just fine. Work started slowing and I

was again looking around at Linux. I then found out
that since I left the circle momentarily, that the above
mentioned distro was no more, sort of. I started
downloading/installing a lot of various distros and
desktop versions.
After a 17 OS multi­boot Linux install of various
distros and all of them alongside two versions of that
other monopoly (for gaming), PCLinuxOS KDE and
Full Monty KDE created a look and feel with their OS
that has become home for me. I played around with
each one of the 17 multi­boot installs for about five
or six months to see what might happen, or not
happen, and found that PCLinuxOS KDE says what
it does and does what it says. It just flat out runs,
and runs, and runs. I especially liked that it utilized
the RPM based repo as well, since I recalled that my
previous Linux installs utilized it.
My old single core AMD XP3200 was showing its
age with today’s KDE. I just couldn't see anything
better than a fresh new up to date system with
PCLinuxOS as the mainstay. KDE was OK on the
old setup, but when multi­tasking, the old system
showed its age.
I really like all the eyecandy of the KDE of today, and
the PCLinuxOS version is by far the easiest to
manage out there for me.
I have converted four people in the last six months
to PCLinuxOS KDE. Two of the four were ready to
have only Linux and to be done with with the other
guys. The other two had family that wanted to utilize
software they already had for some projects and
aren't really going to be the admin to their system or
interested in learning wine or VirtualBox. I'll be their
admin now, and those two now have a dual boot
setup. They are very happy, as am I.

Testimonials

http://en.wikipedia.org/wiki/Mabuhay
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Above: Posted by Crow, July 12, 2012, running KDE 4.
Below: Posted by T6, July 3, 2012, running KDE 4.

Above: Posted by ferry_th, July 3, 2012, running Openbox.
Below: Posted by LKJ, July 2, 2012, running Gnome.

More Screenshot Showcase




